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1. Executive Summary                   
 

A usability test of TRAKnet version 3.1.00 was conducted on December 20, 2017 on site at a participating provider’s 

office. The purpose of this testing was to test and validate the usability of the current user interface, newly implemented 

tasks and features, and provide evidence of usability in the EHR Usability Test (EHRUT). During the usability test, five 

healthcare professionals matching the target demographic criteria served as participants and used the EHRUT in 

simulated, but representative tasks.  

 

This study collected performance data on 40 tasks that are realistic and representative of the kinds of activities a user 

might perform in the TRAKnet version 3.1.00 EHR. Tasks were selected based on their inclusion in 2015 Edition 

Meaningful Use requirements, frequency of use, criticality of function, and those that may be most troublesome for users. 

These tasks were tested in the order of forced-ranked severity of errors due to failure: 

 

This study collected performance data on 40 tasks conducted on an EHR: 

 

• 170.315(a)(1) Computerized provider order entry – medications 

o Task 1: Record Medication Order   

o Task 2: Change Medication Order   

o Task 3: Display Changed Medication Order   

• 170.315(a)(2) Computerized provider order entry – laboratory 

o Task 4: Record Lab Order   

o Task 5: Change Lab Order   

o Task 6: Display Lab Order   

• 170.315(a)(3) Computerized provider order entry – diagnostic imaging 

o Task 7: Record Radiology Order 

o Task 8: Change Radiology Order   

o Task 9: Display Radiology Order 

• 170.315(a)(4) Drug-drug, drug-allergy interaction checks 

o Task 10: Drug-Drug Interaction Radiology Order   

o Task 11: Drug-Allergy Interaction Radiology Order   

o Task 12: Adjust Severity of an Interaction   

• 170.315(a)(5) Demographics 

o Task 13: Record Demographics   

o Task 14: Change Demographics 

o Task 15: Display Demographics 

• 170.315(a)(6) Problem list 

o Task 16: Record Problem   

o Task 17: Resolve/Change Problem 

o Task 18: Display Active and Historical Problems   

• 170.315(a)(7) Medication list 

o Task 19: Record Medication    

o Task 20: Change Medication   

o Task 21: Display Active Medications 

o Task 22: Display Historical Medications   



 
 

  
 

   

• 170.315(a)(8) Medication allergy list 

o Task 23: Record Medication Allergies 

o Task 24: Change Medication Allergies 

o Task 25: Display Active Medication Allergies 

o Task 26: Display Historical Medication Allergies   

• 170.315(a)(9) Clinical decision support 

o Task 26: Create New CDS Rules   

o Task 27: Trigger New CDS Rules 

o Task 28: View Intervention/Resources Information for New CDS Rules 

o Task 29: Trigger CDS Rules From a Referral   

• 170.315(a)(14) Implantable device list 

o Task 30: Record Implantable Device UDI 

o Task 31: Change Status for Implantable Device UDI  

o Task 32: Record Implantable Device UDI   

• 170.315(b)(2) Clinical information reconciliation and incorporation 

o Task 33: Clinical Information Reconciliation   

o Task 34: Generate New CCDA File   

• 170.315(b)(3) Electronic prescribing 

o Task 35: Create New Prescription   

o Task 36: Change Prescription   

o Task 37: Cancel Prescription   

o Task 38: Refill Prescription 

o Task 39: Receive Fill Status Notice 

o Task 40: Request and Receive Medication History   
 
 
 
 
 
 

 
 

 

 

During the 120 minute one-on-one usability test, each participant was greeted by the administrator and asked to review 

and sign an informed consent/release form (included in Appendix 5.4); they were instructed that they could withdraw at 

any time. Participants did have prior experience with various aspects of this EHRUT, but not with some of the 

newer/revised functionally of this version of the EHR being tested (e-Prescribing and Clinical Reconciliation).  A training 

session lasting 1.5 hours, using technical documents used for real end user training, were conducted the day prior to 

testing. 

 

The administrator introduced the test, and instructed participants to complete a series of tasks (given one at a time) using 

the EHRUT. During the testing, the data logger manually timed and recorded user performance data on paper and 

electronically. The administrator did not give the participant assistance in how to complete the task.  

The following types of data were collected for each participant:  

 

• Number of tasks successfully completed within the allotted time without assistance  

• Time to complete the tasks  

• Number and types of errors  

• Path deviations  



 
 

  
 

   

• Participant’s verbalizations  

• Participant’s satisfaction ratings of the system  

 

All participant data was de-identified – no correspondence could be made from the identity of the participant to the data 

collected. Following the conclusion of the testing, participants were asked to complete a post-test questionnaire and were 

not compensated for their time. Various recommended metrics, in accordance with the examples set forth in the NIST 

Guide to the Processes Approach for Improving the Usability of Electronic Health Records (NISTIR 7741), were used to 

evaluate the usability of the EHRUT. A summary of the performance and rating data collected on the EHRUT is found in 

Section 4.1, Data Analysis and Reporting. 

 

The results from the System Usability Scale scored the subjective satisfaction with the system based on performance with 

these tasks to be: Please see document ‘EHR Test-131) 2015 Edition Safety-Enhanced Design 

Checklist_Rev01Nov2016_ReleaseSet01Nov2016’ 

 

In addition to the performance data, the following qualitative observations were made:  

 

Major findings: 

 

• Overall, participants seemed pleased with the product and felt that for the activities they performed on a regular 

basis, it was relatively user-friendly and easy to use.  

• Participants remarked that the new software was easy to navigate and quickly picked up. Overall, participants 

were pleased with the product, with two participants mentioning the new overall look as being a clean 

improvement over past versions. 

• All participants struggled with creating Clinical Decision Rules at first. 

• Four participants remarked that importing the CCDA was not easily noticeable. 

• Of 40 tasks tested requiring the participant to enter, change or retrieve data, 30 of these tasks rated an ‘easy’ for 

all participants. 

 

Areas for improvement:  
 

• Comments from participants indicate users should be able to import a CCDA directly from the patient’s chart. 

• Participants struggled creating Clinical Decision Support Rules and stated with additional references in TRAKnet 

3.1 this could be easier.  



 
 

  
 

   

2. Introduction                   
 

The EHR tested for this study was TRAKnet version 3.1.00 designed to present medical information to healthcare 

providers practicing in a Podiatrist’s office. The application is a Complete Electronic Health Record for the ambulatory 

setting. The software boasts compliance to all meaningful use objectives for the Ambulatory setting in one application. 

The system includes the ability to meet all meaningful use objectives as well as Computerized Medication Administration, 

Pharmacy Management, Medial Records Management, Order Receiving, and Nursing Documentation. The usability 

testing attempted to represent realistic exercises and conditions.  

 

The purpose of this study was to test and validate the usability of the current user interface, and provide evidence of 

usability in the EHR Usability Test (EHRUT).  To this end, measures of effectiveness, efficiency and user satisfaction, 

such as time on task, deviations from optimal path, and errors were captured during the usability testing. 

 

3. Method                   
 

3.1 PARTICIPANTS  

A total of  10 participants, that were representative of our user base, were tested on the EHRUT. Intended users of 

the EHR are physicians, registered nurses, certified nurse assistants, nurse practitioners, and business office personnel. 

Participants in the test represented backgrounds of podiatry, Medical Assistant and medical office administration. 

Participants were recruited by TRAKnet. In addition, participants had no direct connection to the development of the 

EHRUT. Participants were given the opportunity to have the same orientation and level of training as the actual end users 

would have received.  

 

For the test purposes, end-user characteristics were identified and translated into a recruitment screener used to solicit 

potential participants; the recruiting screener is provided in Appendix 5.1. 

 

Recruited participants had a mix of backgrounds and demographic characteristics conforming to the recruitment screener. 

The following is a table (Table 3.1) containing a high level overview of participants by gender, occupation and years of 

experience.  A detailed summary of participant characteristics, including demographics, professional experience, 

computing experience and user needs for assistive technology is found in Appendix 5.2, Participant Demographics. 

Participant names were replaced with Participant IDs so that an individual’s data cannot be tied back to individual 

identities. 
 

Participant Demographics Overview  Table 3.1 

Gender  

 Male: 7 

 Female: 3 

 Total: 10 
   

Occupation/Role  

 Medical Assistant: 3 

 Physician: 5 

 Admin Staff: 2 

   

Years of Experience  

 Years’ Experience: 60+ 

 Average Use of EHR: 3 

 All Paper: 0 

 Some Paper/Some Electronic: 0 

 All Electronic: 10 

   
 



 
 

  
 

   

 

Participants were scheduled for 120 minute sessions with one day in between each session for debrief by the administrator 

and data logger, to reset systems to proper test conditions, and participant schedule considerations. A spreadsheet was 

used to keep track of the participant schedule, and included each participant’s demographic characteristics as provided by 

the recruiting screen.  

 

3.2 STUDY DESIGN  
Overall, the objective of this test was to uncover areas where the application performed well – that is, effectively, 

efficiently, and with satisfaction – and areas where the application failed to meet the needs of the participants. The data 

from this test may serve as a baseline for future tests with an updated version of the same EHR and/or comparison with 

other EHRs provided the same tasks are used. In short, this testing serves as both a means to record or benchmark current 

usability, but also to identify areas where improvements must be made.  

 

During the usability test, participants interacted with one EHR. Each participant used the system in the same location, and 

was provided with the same instructions. The system was evaluated for effectiveness, efficiency and satisfaction as 

defined by measures collected and analyzed for each participant:  

 

• Number of tasks successfully completed within the allotted time without assistance  

• Time to complete the tasks  

• Number and types of errors  

• Path deviations  

• Participant’s verbalizations (comments)  

• Participant’s satisfaction ratings of the system  

 

Additional information about the various measures can be found in Section 3.9 on Usability Metrics.  

 

3.3 TASKS  
A number of tasks were constructed that would be realistic and representative of the kinds of activities a user might 

perform with this EHR and were tested in the order of forced-ranked severity of errors due to failure, 

including:  

• 170.315(a)(1) Computerized provider order entry – medications 

o Task 1: Record Medication Order   

o Task 2: Change Medication Order   

o Task 3: Display Changed Medication Order   

• 170.315(a)(2) Computerized provider order entry – laboratory 

o Task 4: Record Lab Order   

o Task 5: Change Lab Order   

o Task 6: Display Lab Order   

• 170.315(a)(3) Computerized provider order entry – diagnostic imaging 

o Task 7: Record Radiology Order 

o Task 8: Change Radiology Order   

o Task 9: Display Radiology Order 

• 170.315(a)(4) Drug-drug, drug-allergy interaction checks 

o Task 10: Drug-Drug Interaction Radiology Order   

o Task 11: Drug-Allergy Interaction Radiology Order   

o Task 12: Adjust Severity of an Interaction   

• 170.315(a)(5) Demographics 

o Task 13: Record Demographics   



 
 

  
 

   

o Task 14: Change Demographics 

o Task 15: Display Demographics 

• 170.315(a)(6) Problem list 

o Task 16: Record Problem   

o Task 17: Resolve/Change Problem 

o Task 18: Display Active and Historical Problems   

• 170.315(a)(7) Medication list 

o Task 19: Record Medication    

o Task 20: Change Medication   

o Task 21: Display Active Medications 

o Task 22: Display Historical Medications   

• 170.315(a)(8) Medication allergy list 

o Task 23: Record Medication Allergies 

o Task 24: Change Medication Allergies 

o Task 25: Display Active Medication Allergies 

o Task 26: Display Historical Medication Allergies   

• 170.315(a)(9) Clinical decision support 

o Task 26: Create New CDS Rules   

o Task 27: Trigger New CDS Rules 

o Task 28: View Intervention/Resources Information for New CDS Rules 

o Task 29: Trigger CDS Rules From a Referral   

• 170.315(a)(14) Implantable device list 

o Task 30: Record Implantable Device UDI 

o Task 31: Change Status for Implantable Device UDI  

o Task 32: Record Implantable Device UDI   

• 170.315(b)(2) Clinical information reconciliation and incorporation 

o Task 33: Clinical Information Reconciliation   

o Task 34: Generate New CCDA File   

• 170.315(b)(3) Electronic prescribing 

o Task 35: Create New Prescription   

o Task 36: Change Prescription   

o Task 37: Cancel Prescription   

o Task 38: Refill Prescription 

o Task 39: Receive Fill Status Notice 

o Task 40: Request and Receive Medication History   

 

 

Tasks were selected based on their inclusion in the 2015 Edition Meaningful Use requirements, frequency of use, 

criticality of function, and those that may be most troublesome for users. 

 

3.4 PROCEDURES  
Upon arrival, participants were greeted; their identity was verified and matched with a name on the participant schedule. 

Participants were then assigned a participant ID.  Each participant reviewed and signed an informed consent and release 

form (See Appendix 5.4). A representative from the test team witnessed the participant’s signature.  

 

The administrator moderated the session including administering instructions and tasks. The administrator also obtained 

post-task rating data, and took notes on participant comments.  



 
 

  
 

   

Participants were instructed to perform the tasks (see specific instructions below in section 3.8 Participant Instructions):  

• As quickly as possible making as few errors and deviations as possible.  

• Without assistance; administrators were allowed to give immaterial guidance and clarification on tasks, 

but not instructions on use.  

• Without using a think aloud technique.  

 

For each task, the participants were given a written copy of the task. Task timing began once the administrator finished 

reading the task instructions. The task time was stopped once the participant indicated they had successfully completed 

the task. Scoring is discussed below in Section 3.9, Usability Metrics.  

 

Participants' demographic information, task success rate, time on task, errors, deviations, verbal responses, and post-test 

questionnaire were recorded into a spreadsheet.  

 

3.5 TEST LOCATION  
The test facility included a waiting area and a quiet testing room with a table, computer for the participant, and 

moderator’s guide and paper for the administrator. Only the participant and administrator were in the test room.  

To ensure that the environment was comfortable for users, noise levels were kept to a minimum with the ambient 

temperature within a normal range. All of the safety instructions and evacuation procedures were current, in place, and 

visible to the participants.  

 

3.6 TEST ENVIRONMENT  
The EHR would be typically be used in a healthcare office or facility. In this instance, the testing was conducted in a 

conference room set up to simulate an office environment.  

The application was set up by the IT administration.  The EHR was used in a healthcare office/facility. In this instance, 

the testing was conducted from each participant’s own office. 

 

 

3.7 TEST FORMS AND TOOLS  
During the usability test, various documents and instruments were used, including:  

1. Non-Disclosure Agreement 

2. Informed Consent  

3. Moderator’s Guide  

4. Post-test Questionnaire  

5. Incentive Receipt and Acknowledgment Form  

 

Examples of these documents can be found in Appendices 5.3-5.7 respectively. The Moderator’s Guide was devised so as 

to be able to capture required data.  

 

The participant’s interaction with the EHRUT was captured and recorded.  

 

3.8 PARTICIPANT INSTRUCTIONS  
The administrator reads the following instructions aloud to each participant (also see the full moderator’s guide in 

Appendix 5.5):  
 

Thank you for participating in this study. Your input is very important. Our session today will last about 120 minutes. During that time 

you will use an instance of an electronic health record. I will ask you to complete 40 tasks using this system and answer some 

questions. You should complete the tasks as quickly as possible making as few errors as possible. Please try to complete the tasks on 

your own following the instructions very closely. Please note that we are not testing you we are testing the system, therefore if you 

have difficulty all this means is that something needs to be improved in the system. I will be here in case you need specific help, but I 

am not able to instruct you or provide help in how to use the application.  

Overall, we are interested in how easy (or how difficult) this system is to use, what in it would be useful to you, and how we could 

improve it. I did not have any involvement in its creation, so please be honest with your opinions. All of the information you provide 

will be kept confidential and your name will not be associated with your comments at any time. Should you feel it necessary you are 

able to withdraw at any time during the testing.  

 



 
 

  
 

   

For each task, I will read the description to you and say “Begin.” At that point, please perform the task and say “Done” once you 

believe you have successfully completed the task. I would like to request that you not talk aloud or verbalize while you are doing the 

tasks. I will ask you your impressions about the task once you are done.  

 

 

Following the procedural instructions, participants were shown the EHR and were given ten minutes to explore the system 

and make comments. Once this initial overview was complete, the administrator asked five preliminary questions and 

began the testing. Participants were then given 40 tasks to complete. Tasks are listed in the moderator’s guide in Appendix 

5.5.  

 

3.9 USABILITY METRICS  
According to the NIST Guide to the Processes Approach for Improving the Usability of Electronic Health Records, EHRs 

should support a process that provides a high level of usability for all users. The goal is for users to interact with the 

system effectively, efficiently, and with an acceptable level of satisfaction. To this end, metrics for effectiveness, 

efficiency and user satisfaction were captured during the usability testing. The goals of the test were to assess:  

1. Effectiveness of TRAKnet version 3.1.00, by measuring participant success rates and errors 

2. Efficiency of TRAKnet version 3.1.00, by measuring the average task time and path deviations 

3. Satisfaction with TRAKnet version 3.1.00, by measuring ease of use ratings  

 

 

 

3.10 DATA SCORING  
The following table (Table 3.2) details how tasks were scored, errors evaluated, and the time data analyzed. 

 

 

 

 

 

 

 

 

Data Scoring Metrics                  Table 3.2 

MEASURES Rationale and Scoring 

Effectiveness:        

Task Success 

A task was counted as a “Success” if the participant was able to achieve the correct outcome, without 

assistance, within the time allotted on a per task basis.  

The total number of successes were calculated for each task and then divided by the total number of times 

that task was attempted. The results are provided as a percentage.  

Task times were recorded for successes. Observed task times divided by the optimal time for each task is 

a measure of optimal efficiency.  

Optimal task performance time, as benchmarked by expert performance under realistic conditions, is 

recorded when constructing tasks. Target task times used for task times in the Moderator’s Guide must be 

operationally defined by taking multiple measures of optimal performance and multiplying by 2.5 that 

allows some time buffer because the participants are not trained to expert performance. Thus, if expert, 

optimal performance on a task was 20 seconds then allotted task time performance was [20 * 2.5] 50 

seconds. This ratio is aggregated across tasks and reported with mean and variance scores.  

Effectiveness:  

Task Failures 

If the participant abandoned the task, did not reach the correct answer or performed it incorrectly, or 

reached the end of the allotted time before successful completion, the task was counted as a “Failure.” No 

task times were taken for errors.  

The total number of errors was calculated for each task and then divided by the total number of times that 

task was attempted. Not all deviations would be counted as errors. This is also expressed as the mean 

number of failed tasks per participant.  

On a qualitative level, an enumeration of errors and error types are collected. 



 
 

  
 

   

Effectiveness:   

Task Deviations 

The participant’s path (steps) through the application was recorded. Deviations occur if the participant, 

for example, went to a wrong screen, clicked on an incorrect menu item, followed an incorrect link, or 

interacted incorrectly with an on-screen control. This path was compared to the optimal path. The number 

of steps in the observed path is divided by the number of optimal steps to provide a ratio of path 

deviation.  Task deviations are reported. Optimal paths (procedural steps) are recorded when constructing 

tasks.  

Efficiency:       

Task Time 

Each task was timed from when the administrator said “Begin” until the participant said, “Done.” If he or 

she failed to say “Done,” the time was stopped when the participant stopped performing the task. Only 

task times for tasks that were successfully completed were included in the average task time analysis. 

Average time per task was calculated for each task. Variance measures (standard deviation and standard 

error) were also calculated. 

Satisfaction:   

Task Rating 

Participant’s subjective impression of the ease of use of the application was measured by administering 

both a simple post-task question as well as a brief set of post-session questions. After each task, the 

participant was asked to rate “Overall, this task was:” on a scale of 1 (Very Easy) to 5 (Very Difficult). 

These data are averaged across participants. Common convention is that average ratings for systems 

judged easy to use should be 3.3 or below. 

 

 

  



 
 

  
 

   

4. Results                   
 

4.1 Data Analysis and Reporting  

The results of the usability test were calculated according to the methods specified in the Usability Metrics section above. 

Participants who failed to follow session and task instructions had their data excluded from the analyses.  

 

The results of the usability test were calculated according to the methods specified in the Usability Metrics section above.  

Data collection and interpretation of the results were successful for all participants, and there were no technical issues 

during the testing.   

This study collected performance data on 40 tasks that are realistic and representative of the kinds of activities a user 

might perform in the TRAKnet version 3.1.00. Tasks were selected based on their inclusion in 2015 Edition Meaningful 

Use requirements, frequency of use, criticality of function, and those that may be most troublesome for users.  

The usability testing results are detailed in the table below, based on the order of forced-ranked severity of errors due to 

failure.  The results should be seen in light of the objectives and goals outlined in Section 3.2, Study Design. The data 

should yield actionable results that, if corrected, would result in material, positive impacts on user performance. 

 

The usability testing results for the EHRUT can be found in the document listed below. The results should be seen in light 

of the objectives and goals outlined in Section 3.2 Study Design. The data should yield actionable results that, if corrected, 

yield material, positive impact on user performance. 

 

Detailed Document - (EHR Test-131) 2015 Edition Safety-Enhanced Design 

Checklist_Rev01Nov2016_ReleaseSet01Nov2016 

 
 

4.2 Discussion of the Findings  
All participants rated 37 of the 40 tasks as ‘Easy’.  Below are details of all tasks which were not completed, or contained 

path deviations, or technical issues. 

 

Task 26 was found to be difficult by most of our participants. This was due to user workflow and fully understanding 

what this measure is for. All users recommended that we specifically place instructions directly in the EHR system for 

assistance, instead of having a link to our wiki page. 

 

Task 30 was easily completed by all participant, once they were able to enter the device data (number). 

 

Task 33 was completed by all participants, however most users recommended that we add additional workflows. This 

could be accomplished by allowing the end user to import the individual CCDA directly into the patients chart. 

 

Task 1 was easily completed by all participants, with one participant expressing that the tab titled Lexicomp was initially 

confusing for searching for a medication, as the participant did not immediately make the connection that Lexicomp was 

the medication database to search. 

 

 

 

4.3 Effectiveness 
While a software program may be functional, successfully performing required tasks, the manner in which a user interacts 

with the software to perform these tasks may be cumbersome and confusing, causing it to be unusable.  In evaluation of 

the 40 tasks tested, three tasks failed for a majority of the participants due to difficulty of completion. Participants were 

unable to create their Clinical Decision Support rules without assistance. This indicates that the workflow for creating 

these needs to have documentation explaining each step within the window to be more clear and concise.  

 

Overall of the 400 individual tasks tested, 388 tasks tested successfully, resulting in a 97% success rate across all 

participants.   

 



 
 

  
 

   

4.4 Efficiency 
Based upon observations of task times and deviations, of the 388 instances of successful tasks, 388 were completed within 

the estimated optimal task performance time.  Times were benchmarked by expert performance under realistic conditions, 

and multiplied by a 2.5 second time buffer to allow for the fact the participants in this study are not expert users.   

 

4.5 Satisfaction  
Participants were asked to rate each task individually on a scale of 1= Very Easy to 5= Very Difficult. Collectively, 38 of 

40 tasks were rated with a “1= Very Easy”.  Two tasks, numbers 30, 33, ranked a 2 or higher rating across all participants. 

One task, 26, was ranked a 4 by most participants for difficulty understanding the measure. 

 

All participants indicated that, while the software was a variation from what they had used in the past, the tasks were 

straight-forward and easy to complete, and the software was overall easy to navigate. 

 

 

 

4.6 Major Findings 
Participants were overall very pleased with the product and eight out of ten expressed appreciation for the amount of 

overall data available on the main patient detail screen and ease of access to said information.  Participants noted the 

importance of having current problems, vitals, allergies and medication lists prominent on the main patient detail screen.  

Participants stated the application seemed to have a good flow from one area to the next with easy access icons and was 

relatively “user-friendly,” seemed easy to learn and easy to use. 

 

The Clinical Decision Support Interventions are in place, however more attention to methods of alerting the uses on how 

to create these should be revisited, as most users expressed difficulty. 

 

 

4.7 Areas for Improvement  
 

Seven of ten participants expressed the need for the Clinical Decision Support window to have instructions built in. 

 

All participants struggled with creating the Clinical Decision Support rules. 

 

Two of ten participants indicated slowness in the system while working.  
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1. Recruiting Screen                  Page 1 of 2 
 
We are recruiting individuals to participate in a usability study for an 

electronic health record. We would like to ask you a few questions to gather 

participation information. This should only take a few minutes of your time. 

This is strictly for research purposes. You will be paid to participate in Training 

and Testing.  

  

Please answer the following questions: 

 

1. Are you male or female?  Male    Female    

 

2. Have you participated in a focus group or usability test in the  

past 6 months?    Yes    No     

 

3. Do you, or does anyone in your home, work in marketing research, usability research, web 

design, or other computer work?   Yes    No     

        

4. Do you, or does anyone in your home, have a commercial or research interest in an electronic health record software or 

consulting company?    Yes    No     

 

5. Which of the following best describes your age?  

 23 to 39      40 to 59     60 to 74     75 or older    

 

6. Which of the following best describes your race or ethnic group?  

 Caucasian    Asian    Black/African American        Latino/a or Hispanic        Other    

 

7. Do you require any assistive technologies to use a computer?  Yes      No     

 If Yes, Please Describe:                       

 

Professional Demographics: 

 

8. What is your current position and title? (Must be healthcare related)  

 

_____RN:    Specialty       

 

_____Physician:  Specialty       

 

_____Resident:   Specialty       

 

_____Administrative Staff  

 

_____Other Medical:  Specialty       

 

9. How long have you held this position?     

 

10. Describe your work location (or affiliation) and environment? [e.g., private practice, health system, government clinic, 

etc.]                            

 

11. Which of the following describes your highest level of education? 

High School/GED        Some College       College Graduate (RN/BSN)      Post graduate (MD/PhD)      

 Other: Please Describe:                       

 

 

 



 
 

  
 

   

1. Recruiting Screen                  Page 2 of 2 
 

Computer Expertise: 

 

12. Besides reading email, what professional activities do you do on the computer? 

Access EHR             Research           News           Shopping/Banking           Digital Pictures    

Programming           Microsoft Office Products             

 

13. About how many hours per week do you spend on the computer?  

0 to 10             11 to 25              26 or More             

 

14. What computer platform do you usually use? [e.g., Mac, Windows, etc.]  

                             

 

15. What Internet browser(s) do you usually use? [e.g., Firefox, IE, AOL, etc.]  

                             

 

16. In the last month, how often have you used an electronic health record?  

                             

 

17. How many years have you used an electronic health record?               

 

18. How many EHRs do you use or are you familiar with?                

 

19. How does your work environment record/retrieve patient records?  

On Paper             Some Paper/Some Electronic              All Electronic     

 

 

Contact Information: 

Name of participant:                         

Address:            City:       State:    Zip:     

Daytime phone:              Evening Phone:           Cell phone:       

Email address:                           

 

Before your session starts, we will ask you to sign a release form allowing us to videotape your session. The videotape 

will only be used internally for further study if needed. Will you consent to be videotaped?    

Yes    No     

 

This study will take place at your office. 

 

 

 

 

 

  



 
 

  
 

   

5.2. Participant Demographics 
 

Participant High Level Overview 
  

Gender   

  Male: 7 

  Female: 3 

  Total: 10 

      

Occupation/Role   

  Medical Assistant: 3 

  Physician: 5 

  Admin Staff: 2 

      

Years of Experience   

  Years’ Experience: 60+ 

  Average Use of EHR: 3 

  All Paper: 0 

  
Some Paper/Some 

Electronic: 0 

  All Electronic: 10 

      

 

 

Participant Demographics Collection Form             

 

Part 

ID Gender Age Education 

Occupation 

/ Role 

Professional 

Experience 

Computer 

Experience 

Product 

Experience 

Assistive 

Technology 

Needs 

1 1001 M 

20-
29 

High 

School 

Medical 

Assistant 1 Experienced 13 NA 

2 1002 F 

20-
29 

Associate 
degree 

Medical 

Assistant 4. Experienced 26 NA 

3 1003 M 

30-
39 Doctorate DPM 6 Experienced 32 NA 

4 1004 F  

30-
39 Doctorate DPM  7  Experienced 32 NA  

5  1005     M 

50 - 

59  Doctorate DPM 27  Experienced 32 NA  

6  1006  M 

40-

49  Bachelors   Admin  10  Experienced  32 NA  

7  1007  F 

 20-

29 

High 

School  

 Medical 

Assistant  4 Experienced   32  NA 

8  1008  M 

 30-

39 Bachelors   Admin  12 Experienced   32  NA 

9  1009  M 

 30-

39 Doctorate  DPM  4 Experienced   32  NA 

10  1010  M 

 20-

29  Doctorate  DPM  1 Experienced   15  NA 



 
 

  
 

   

                    

 

 

5.3. Non-Disclosure Agreement 
  

 

Non-Disclosure Agreement  
 

 

THIS AGREEMENT is entered into as of     , 2017, between _________________________ (“the 

Participant”) and the testing organization. 

 

The Participant acknowledges his or her voluntary participation in today’s usability study may bring the 

Participant into possession of Confidential Information. The term "Confidential Information" means all 

technical and commercial information of a proprietary or confidential nature which is disclosed by TRAKnet or 

otherwise acquired by the Participant, in the course of this study.  

 

By way of illustration, but not limitation, Confidential Information includes trade secrets, processes, formulae, 

data, know-how, products, designs, drawings, computer aided design files and other computer files, computer 

software, ideas, improvements, inventions, training methods and materials, marketing techniques, plans, 

strategies, budgets, financial information, and/or forecasts.  

 

Any information the Participant acquires relating to this product during this study is confidential and proprietary 

to TRAKnet, and is being disclosed solely for the purposes of the Participant’s participation in today’s usability 

study.  

 

 

By signing this form the Participant acknowledges that she or he will receive monetary compensation for 

feedback and will not disclose this confidential information obtained today to anyone else or any other 

organizations.  

 

 

 

Participant’s printed name:                

 

 

Signature: _____________________________________ Date: ____________________ 

 
           

 

 

 

 

 

 

 

 

 

 

  



 
 

  
 

   

5.4. Informed Consent 
 

 

Informed Consent  
 

TRAKnet would like to thank you for participating in this study. The purpose of this study is to evaluate an 

electronic health records system. If you decide to participate, you will be asked to perform several tasks using 

the prototype and give your feedback. The study will last about 120 minutes. At the conclusion of the test, you 

will be compensated for your time.  

 

Participant Agreement  
I understand and agree that as a voluntary participant in the present study conducted by TRAKnet. I am free to 

withdraw consent or discontinue participation at any time.  

I understand and agree that the purpose of this study is to make software applications more useful and usable in 

the future.  

 

I understand and agree that the data collected from this study may be shared with outside affiliates and 

certification bodies of TRAKnet. 

 

I understand and agree that data confidentiality is assured, because only de-identified data – i.e., identification 

numbers not names – will be used in analysis and reporting of the results.  

 

I agree to immediately raise any concerns or areas of discomfort with the study administrator. I understand that 

I can leave at any time.  

 

Please check one of the following:  

 

_____YES, I have read the above statement and agree to be a participant.  

 

_____NO, I choose not to participate in this study.  

 

 

Signature: _____________________________________ Date: ____________________ 
 

 

 

 

 

 

 

 

  



 
 

  
 

   

5.5. Moderator’s Guide and Orientation 

Usability Test Moderator’s Guide  
 

Administrator:             

 

Data Logger:              

 

Date:       Time of Testing:       

 

Participant #:     Test Patient:      Login:     

 

Location:  

 

 

Prior to testing: 
 Confirm schedule with Participants  

 Ensure EHRUT lab environment is running properly  

 Ensure lab and data recording equipment is running properly  

 

Prior to each participant:  
 Reset application  

 Start session recordings with Usability Studio 

 

Prior to each task:  
 Reset application to starting point for next task  

 

After each participant:  
 End session recordings with Usability Studio  

 

After all testing:  
 Back up all video and data files  - OPTIONAL 

 
  



 
 

  
 

   

Orientation (10 minutes)  
Thank you for participating in this study. Your input is very important. Our session today will last about 120 

minutes.   During that time you will use an instance of an electronic health record. I will ask you to complete 40 

tasks using this system and answer some questions. You should complete the tasks as quickly as possible 

making as few errors as possible. Please try to complete the tasks on your own following the instructions very 

closely. Please note that we are not testing you we are testing the system, therefore if you have difficulty all this 

means is that something needs to be improved in the system. I will be here in case you need specific help, but I 

am not able to instruct you or provide help in how to use the application.  

 

Overall, we are interested in how easy (or how difficult) this system is to use, what in it would be useful to you, 

and how we could improve it. I did not have any involvement in its creation, so please be honest with your 

opinions. All of the information you provide will be kept confidential and your name will not be associated with 

your comments at any time. Should you feel it necessary you are able to withdraw at any time during the 

testing.  

 

For each task, I will read the description to you and say “Begin.” At that point, please perform the task and say 

“Done” once you believe you have successfully completed the task. I would like to request that you not talk 

aloud or verbalize while you are doing the tasks. I will ask you your impressions about the task once you are 

done.  

 

The product you will be using today is TRAKnet version 3.1.00; an electronic medical records system.  Some of 

the data you will see in patient electronic charts may not make sense as it is placeholder (sample) data.  

 

We are recording the audio and screenshots of our session today. All of the information that you provide will be 

kept confidential and your name will not be associated with your comments at any time.  

Do you have any questions or concerns?  

                             

Preliminary Questions (10 minutes)  

What is your job title / appointment?                     

 

How long have you been working in this role?                  

 

What are some of your main responsibilities?                  

 

Tell me about your experience with electronic health records: 

                             

                             

This is the application you will be working with. Have you heard of it?  Yes ____ No     

If so, tell me what you know about it:                    

Show test participant the EHR Usability Test.  

 

Please don’t click on anything just yet. What do you notice? What are you able to do here? Please be specific. 

                               

                               

 

 

5. Tasks  



 
 

  
 

   

 
Practice ID:                               
 

170.315(a)(1) Computerized provider order entry – medications 

a.1  Task 1: Record Medication Order         

For this test you will enter a medication order for a patient. In doing this, please use the below information: 

Patient Name: CPOE Test 

Medication Order Details: 

Medication: Coumadin 3mg 

Dispense: 15 

Refills: 0 

Sig.: Take twice per day with full glass of water. 

Substitution: Substitution Allowed 

Pharmacy: TX Pharmacy 10.6MU 

Please print the medication order. 

 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: RX > Prescribe > Search for Coumadin > Fill in medication order information > Finalize and 

Print. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

a.1  Task 2: Change Medication Order         

For this test you will change the medication order for a patient. In doing this, please use the below information: 

Patient Name: CPOE Test 

Medication Order to Change: 

Medication: Coumadin 3mg 

Sig.: Take twice per day with full glass of water. 

Cancel the above medication.  

Then, prescribe a new one: 

Medication Order Details: 



 
 

  
 

   

Medication: Coumadin 6mg 

Dispense: 15 

Refills: 0 

Sig.: Take once per day with full glass of water. 

Substitution: Substitution Allowed 

Pharmacy: TX Pharmacy 10.6MU 

Please print the medication order. 

 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: RX > Cancel old medication > Prescribe > Search for Coumadin > Fill in medication order 

information > Finalize and Print. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

a.1  Task 3: Display Changed Medication Order        

For this test you will review the new medication order for a patient. In doing this, please use the below 

information: 

Patient Name: CPOE Test 

Medication Order Details: 

Medication: Coumadin 6mg 

Dispense: 15 

Refills: 0 

Sig.: Take once per day with full glass of water. 

Substitution: Substitution Allowed 

Pharmacy: TX Pharmacy 10.6MU 

Please review the change. 

 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           



 
 

  
 

   

                             

 

Task Time: ________ Seconds  

 

Optimal Path: RX > Show Deleted > Review that both old and new order are present. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 
 

170.315(a)(2) Computerized provider order entry – laboratory 

a.2  Task 4: Record Lab Order         

For this test you will create a new lab order for a patient. In doing this, please use the below information: 

Patient Name: CPOE Labs 

Laboratory Order Details: 

Vendor: ABC Labs 

Code: 17855-8 Hemoglobin A1c (glycated HgB)/Hemoglobin.total [Moles] in Blood by Calculated 

Date Ordered: (today’s date) 

Date Sent: (today’s date) 

Specimen Source: left arm 

Please link the lab order to the encounter dated 10/15/2017. 

 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Orders > Lab Orders > Add > Populate above information. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 



 
 

  
 

   

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

a.2  Task 5: Change Lab Order         

For this test you will change a previously entered lab order for a patient. In doing this, please use the below 

information: 

Patient Name: CPOE Labs 

Laboratory Order to Change: 

Vendor: ABC Labs 

Code: 17855-8 Hemoglobin A1c (glycated HgB)/Hemoglobin.total [Moles] in Blood by Calculated 

Date Ordered: (today’s date) 

Date Sent: (today’s date) 

Specimen Source: left arm 

Please change the above lab order to the following: 

Vendor: New Lab 

Code: 17855-8 Hemoglobin A1c (glycated HgB)/Hemoglobin.total [Moles] in Blood by Calculated 

Date Ordered: (today’s date) 

Date Sent: (today’s date) 

Specimen Source: right arm 

 

 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Orders > Lab Orders > Modify > Change the above information. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  

 
 

a.2  Task 6: Display Lab Order         

For this test you will review a previously entered lab order for a patient. In doing this, please use the below 

information: 



 
 

  
 

   

Patient Name: CPOE Labs 

Laboratory Order to Review: 

Vendor: New Lab 

Code: 17855-8 Hemoglobin A1c (glycated HgB)/Hemoglobin.total [Moles] in Blood by Calculated 

Date Ordered: (today’s date) 

Date Sent: (today’s date) 

Specimen Source: right arm 

 

 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Orders > Lab Orders > Modify > Change the above information. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  

 

170.315(a)(3) Computerized provider order entry – diagnostic imaging 

a.3  Task 7: Record Radiology Order        

For this test you will create a new radiology order for a patient. In doing this, please use the below information: 

Patient Name: CPOE Radiology 

Radiology Order Details: 

Vendor: Flower Hospital 

Code: 24709-8 Foot X-ray 

Date Ordered: (today’s date) 

Date Sent: (today’s date) 

Please link the radiology order to the encounter dated 10/21/2017. 

 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           



 
 

  
 

   

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Orders > Radiology Orders > Add > Enter the above information. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

a.3  Task 8: Change Radiology Order        

For this test you will modify a previously added radiology order for a patient. In doing this, please use the 

below information: 

Patient Name: CPOE Radiology 

Radiology Order Details: 

Vendor: Flower Hospital 

Code: 24709-8 Foot X-ray 

Date Ordered: (today’s date) 

Date Sent: (today’s date) 

Please update this to the following: 

Vendor: Opal Hospital 

Code: 24709-8 Foot X-ray 

Date Ordered: (yesterday’s date) 

Date Sent: (today’s date) 

 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Orders > Radiology Orders > Modify > View the above information. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             



 
 

  
 

   

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

a.3  Task 9: Display Radiology Order        

For this test you will review a previously added radiology order for a patient. In doing this, please use the below 

information: 

Patient Name: CPOE Radiology 

Vendor: Opal Hospital 

Code: 24709-8 Foot X-ray 

Date Ordered: (yesterday’s date) 

Date Sent: (today’s date) 

 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Orders > Radiology Orders > Modify > View the above information. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

170.315(a)(4) Drug-drug, drug-allergy interaction checks 

a.4  Task 10: Drug-Drug Interaction Radiology Order     

For this test you will trigger a drug-drug interaction by entering a new medication. In doing this, please use the 

below information: 

Patient: Drug Alert 

Medication to prescribe: Coumadin 3mg 

Alert type: drug-drug 

 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           



 
 

  
 

   

                             

 

Task Time: ________ Seconds  

 

Optimal Path: RX > Prescribe > Search for Coumadin > Select Coumadin and click next > An alert will pop 

up for a drug-drug interaction. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

a.4  Task 11: Drug-Allergy Interaction Radiology Order     

For this test you will trigger a drug-allergy interaction by entering a new medication. In doing this, please use 

the below information: 

Patient: Allergy Alert 

Medication to prescribe: Bactrim 400mg-80mg tablet 

Alert type: drug-allergy 

 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: RX > Prescribe > Search for Bactrim > Select Bactrim and click next > An alert will pop up for 

a drug-allergy interaction. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 



 
 

  
 

   

a.4  Task 12: Adjust Severity of an Interaction     

For this test you will trigger a drug-allergy interaction by entering a new medication and then alter the severity 

of that interaction. In doing this, please use the below information: 

Patient: Allergy Alert 

Medication to prescribe: Bactrim 400mg-80mg tablet 

Alert type: drug-allergy 

Alter the severity of this interaction and set to Severe. 

 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: RX > Prescribe > Search for Bactrim > An alert will pop up for a drug-allergy interaction > 

Click Change Severity. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

170.315(a)(5) Demographics 

a.5  Task 13: Record Demographics     

For this test you will create a new patient with a specific set of demographic information. In doing this, please 

use the below information: 

 First Name: BrucePasswprd1 

 

 Last Name: Wayne 

Date of Birth: 10/15/1974 

Zip: 48072 

Preferred Language: English 

Birth Sex: Male 

Race: White - Irish 

Ethnicity: Not Hispanic or Latino 

Sexual Orientation: Bisexual 

Gender Identity: Genderqueer, neither exclusively male nor female. 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  



 
 

  
 

   

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Add New Patient > Enter in demographics > Save. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

a.5  Task 14: Change Demographics     

For this test you will change a patient’s demographic information. In doing this, please use the below 

information: 

 First Name: Bruce 

 Last Name: Wayne 

Date of Birth: 11/15/1964 

Preferred Language: Spanish 

Birth Sex: Female 

Race: Asian - Chinese 

Ethnicity: Hispanic or Latino 

Sexual Orientation: Straight or heterosexual 

Gender Identity: Male 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Search for patient > Click Demographics > Update Demographics > Save. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 



 
 

  
 

   

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  

 

a.5  Task 15: Display Demographics     

For this test you will display a patient’s demographic information. In doing this, please use the below 

information: 

 First Name: Bruce 

 Last Name: Wayne 

Date of Birth: 11/15/1964 

Preferred Language: Spanish 

Birth Sex: Female 

Race: Asian - Chinese 

Ethnicity: Hispanic or Latino 

Sexual Orientation: Straight or heterosexual 

Gender Identity: Male 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Search for patient > Click Demographics > Review. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  

 

170.315(a)(6) Problem list 

a.6  Task 16: Record Problem     

For this test you will document a problem for a patient. In doing this, please use the below information: 

Patient Name: Bruce Wayne 

Add the following problems: 

M84.374A – Stress fracture, right foot, initial encounter for fracture 

E10.618 – Type 1 diabetes mellitus with other diabetic arthropathy 

Success:  

 Easily completed   



 
 

  
 

   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Search for patient > Problems/Diagnoses > Search for and add. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

a.6  Task 17: Resolve/Change Problem     

For this test you will resolve a problem for a patient. In doing this, please use the below information: 

Patient Name: Bruce Wayne 

Resolve the following problems: 

M84.374A – Stress fracture, right foot, initial encounter for fracture 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Search for patient > Problems/Diagnoses > Resolved. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  

 



 
 

  
 

   

a.6  Task 18: Display Active and Historical Problems     

For this test you will review both active and historical problems for a patient. In doing this, please use the below 

information: 

Patient Name: Bruce Wayne 

Confirm the following problem is active: 

E10.618 – Type 1 diabetes mellitus with other diabetic arthropathy 

Confirm the following problem is resolved: 

M84.374A – Stress fracture, right foot, initial encounter for fracture 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Search for patient > Problems/Diagnoses > Resolved. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  

 

170.315(a)(7) Medication list 

a.7  Task 19: Record Medication     

For this test you will record a new medication on the patient’s chart. In doing this, please use the below 

information: 

Patient Name: Debra Smith 

Add the following medication: 

Cortizone-10 1% cream 

Sig: “Apply to area as needed for itchiness.” 

Add the following medication: 

 Zofran 4 mg tablet 

 Sig: “Take one every four hours as needed for nausea.” 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             



 
 

  
 

   

 

Task Time: ________ Seconds  

 

Optimal Path: Search for patient > Medications/Allergies > Add Medication. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  

 

a.7  Task 20: Change Medication     

For this test you will change a medication on the patient’s chart. In doing this, please use the below information: 

Patient Name: Debra Smith 

Change the following medication: 

Cortizone-10 1% cream 

Sig: “Apply to area as needed for itchiness.” 

Change the following field: 

 Date Stopped: (Today’s Date) 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Search for patient > Medications/Allergies > Select Medication > Modify. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  

 

a.7  Task 21: Display Active Medications     

For this test you will review active medications on the patient’s chart. In doing this, please use the below 

information: 



 
 

  
 

   

Patient Name: Debra Smith 

View the list of Active medications only and ensure it shows the following: 

 Zofran 4 mg tablet 

 Sig: “Take one every four hours as needed for nausea.” 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Search for patient > Medications/Allergies > View list of medications. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  

 

a.7  Task 22: Display Historical Medications     

For this test you will review historical medications on the patient’s chart. In doing this, please use the below 

information: 

Patient Name: Debra Smith 

View the list of inactive medications only and ensure it shows the following: 

Cortizone-10 1% cream 

Sig: “Apply to area as needed for itchiness.” 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Search for patient > Medications/Allergies > Set Status to Inactive > View. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           



 
 

  
 

   

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  

 

170.315(a)(8) Medication allergy list 

a.8  Task 23: Record Medication Allergies     

For this test you will record medication allergies on the patient’s chart. In doing this, please use the below 

information: 

Patient Name: Barry Allen 

Add the following medication allergies: 

Cephalosporin C – Reaction: Rash 

Sulfa drugs – Reaction: Hives 

Demerol – Reaction: Hives 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Search for patient > Medications/Allergies > click Add under Allergies > Search for allergy > 

input all necessary data. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

a.8  Task 24: Change Medication Allergies     

For this test you will change medication allergies on the patient’s chart. In doing this, please use the below 

information: 

Patient Name: Barry Allen 

Modify the following medication allergy: 

Sulfa drugs 

Change the reaction to: Moderate Hives 

Change the onset date to: 1/1/1997 

Deactivate the following allergy: 



 
 

  
 

   

 Cephalosporin C 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Search for patient > Medications/Allergies > Modify two allergies as defined above. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  

 

a.8  Task 25: Display Active Medication Allergies     

For this test you will review active medication allergies on the patient’s chart. In doing this, please use the 

below information: 

Patient Name: Barry Allen 

Confirm that the following medication allergies are active: 

Sulfa drugs – Reaction: Moderate Hives 

Demerol – Reaction: Hives 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Search for patient > Medications/Allergies > Confirm that the two above allergies are listed in 

the Allergies section. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

Rating:  



 
 

  
 

   

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  

 

a.8  Task 26: Display Historical Medication Allergies     

For this test you will review all historical medication allergies on the patient’s chart. In doing this, please use 

the below information: 

Patient Name: Barry Allen 

Confirm that the following medication allergies are inactive but still documented: 

Cephalosporin C – Reaction: Rash 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Search for patient > Medications/Allergies > Set Status filter to Inactive > Confirm that the 

above allergy is listed in the Allergies section. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

170.315(a)(9) Clinical decision support 

a.9  Task 26: Create New CDS Rules     

For this test you will create seven CDS rules using the following criteria: 

Problem List: 

 Name: Suggest oral treatment for onychomycosis 

 Suggested Intervention: Medication – terbinafine 

 Criteria: Problem - onychomycosis 

Medication List: 

 Name: Perform a liver enzyme lab 

 Suggested Intervention: Laboratory - 24325-3 – Hepatic function pane (CMS) 

 Criteria: Medication - terbinafine 

Medication Allergy List: 

Name: Major allergy alert 

Suggested Intervention: Other - Flag the patient’s chart with an allergy tag 

 Criteria: Medication Allergy – penicillin  

Demographic:  



 
 

  
 

   

 Name: suggest follow up with PCP for pneumococcal vaccine 

 Suggested Intervention: Other – suggest follow up with PCP for pneumococcal vaccine 

 Criteria: Age greater than or equal to 65 

Laboratory Test: 

 Name: Nail discoloration 

 Suggested Intervention: Diagnoses - onychomycosis 

 Criteria: Lab - 55306-5 – Fungus [Presence] in Nail by KOH preparation 

Vital Signs: 

 Name: Suggest follow-up with PCP 

 Suggested Intervention: Diagnoses – Benign Essential Hypertension 

 Criteria: Vital Sign – Diastolic >= 90 

Demographic and Vital Signs Combined: 

Name: Suggest follow-up with PCP 

 Suggested Intervention: Diagnoses – Benign Essential Hypertension 

 Criteria: Vital Sign – Diastolic >= 90 

 Age: Over > 50 

 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Reports > Patient Lists > Rules and Lists > Add. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  

 

a.9  Task 27: Trigger New CDS Rules     

For this test you will trigger the following CDS rules by viewing the below patients: 

Problem List: Suggest oral treatment for onychomycosis 

 CDS One 

Medication List: Perform a liver enzyme lab 

 CDS Two 

Medication Allergy List: Major allergy alert 

 CDS Three 

Demographic: suggest follow up with PCP for pneumococcal vaccine 

 CDS Four 

Laboratory Test: Nail discoloration 



 
 

  
 

   

 CDS Five 

Vital Signs: Suggest follow-up with PCP 

CDS Six 

Demographic and Vital Signs Combined: Suggest follow-up with PCP 

CDS Seven 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Reports > Patient Lists > Reports > Click on the CDS report and verify the listed patient is 

present > View CDS. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

a.9  Task 28: View Intervention/Resources Information for New CDS Rules    

For this test you will trigger the following CDS rules and then few the suggested intervention/education 

materials using the Infobutton standard: 

Problem List: 

 CDS One 

Medication List: 

 CDS Two 

Demographic:  

 CDS Four 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Reports > Patient Lists > Reports > Click on the CDS report and verify the listed patient is 

present > Click on Rules and Lists > Modify CDS Rule > Click on Infobutton to get additional material. 

 Correct  



 
 

  
 

   

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

a.9  Task 29: Trigger CDS Rules From a Referral    

For this test you will trigger several CDS rules based on a referral/transition of care from another provider. The 

patient to use will be the following: 

Alice Newman 

You will import the following CCDA file to reconcile the patient’s information. 

 

Exports.7z

  
You will then confirm that the following CDS results are populating: 

 Name: Yearly Exam Reminder 

 Suggested Intervention: Other – suggest follow up with PCP for regular physical 

 Criteria: Age greater than or equal to 45 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Import the CCDA > Search for the patient > Click CDS > Confirm rules are popping as defined 

above. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

170.315(a)(14) Implantable device list 

a.14  Task 30: Record Implantable Device UDI    

For this test you will record a UDI/Implantable Device for a patient using the below information: 



 
 

  
 

   

Patient Name: Ronan Lynch 

Implantable Device information: 

 (01)10884521062856(11)141231(17)150707(10)A213B1(21)1234 

The following details should populate: 

• Lot: A213B1 

• Serial number: 1234 

• Expiration date: 2015-07-07 

• Manufactured date: 2014-12-31 

• GMDN PT Name: Polyester suture   

• Brand Name: Ti-Cron 

• Model Number: 88863380-82 

• Company Name: Covidien LP 

• MRI safety information labeling contain: Labeling does not contain MRI Safety Information  

• Required labeling rubber: No 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Actions>Implantable devices>Add>Search for UDI>Obtain Description>Save 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

a.14  Task 31: Change Status for Implantable Device UDI    

For this test you will change a UDI/Implantable Device status for a patient using the below information: 

Patient Name: Ronan Lynch 

Implantable Device to change: 

 (01)10884521062856(11)141231(17)150707(10)A213B1(21)1234 

Lot: A213B1 

Serial number: 1234 

Expiration date: 2015-07-07 

Manufactured date: 2014-12-31 

GMDN PT Name: Polyester suture   

Brand Name: Ti-Cron 

Model Number: 88863380-82 

Company Name: Covidien LP 



 
 

  
 

   

MRI safety information labeling contain: Labeling does not contain MRI Safety Information  

Required labeling rubber: No 

Mark the UDI as “Inactive.” 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Actions>Implantable devices>Uncheck Active box>OK 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

a.14  Task 32: Record Implantable Device UDI    

For this test you will review all information about a UDI/Implantable Device for a patient using the below 

information: 

Patient Name: Ronan Lynch 

Implantable Device to review: 

 (01)10884521062856(11)141231(17)150707(10)A213B1(21)1234 

Lot: A213B1 

Serial number: 1234 

Expiration date: 2015-07-07 

Manufactured date: 2014-12-31 

GMDN PT Name: Polyester suture   

Brand Name: Ti-Cron 

Model Number: 88863380-82 

Company Name: Covidien LP 

MRI safety information labeling contain: Labeling does not contain MRI Safety Information  

Required labeling rubber: No 

Verify that all of the above UDI information is readable and present. 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 



 
 

  
 

   

Task Time: ________ Seconds  

 

Optimal Path: Actions>Implantable devices>Add>Search for UDI>Obtain Description>Save 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  

 

170.315(b)(2) Clinical information reconciliation and incorporation 

b.2  Task 33: Clinical Information Reconciliation    

For this test you will import a CCDA file for a patient and reconcile the medications, medication allergies and 

problems for a patient. You will use the below information: 

Patient Name: Turner, Susan 

File Name:  SUSAN SUSY TURNER File One 

Medications to Reconcile: 

Ceftriaxone 100MG/ML 

Tylenol 500MG 

Medication Allergies to Reconcile: 

Penicillin G Benzathine 

Problems to Reconcile: 

Fever 

Overweight 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Tools>Clinical Summary>Import>Select File>Find import>Select>Associate (select 

patients)>Select CCDA (patients chart)>Import CCDA>Select Document>Reconcile>Select data by using the 

checkboxes>Use the arrows to move the data to the right>Reconcile All>Close Window 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

Rating:  



 
 

  
 

   

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

b.2  Task 34: Generate New CCDA File    

For this test you will generate a CCDA file for the above patient, demonstrating that newly reconciled data will 

pull over. You will use the below information: 

Patient Name: Turner, Susan 

File name: SUSAN SUSY TURNER File Two 

Medications to Reconcile: 

Aranesp 0.5 MG/ML 

Tylenol 500MG 

Medication Allergies to Reconcile: 

Ampicillin 

Penicillin G Benzathine 

Problems to Reconcile: 

Essential hypertension 

Severe Hypothyroidism 

Chronic rejection of renal transplant 

Fever 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Tools>Clinical Summary>Import>Select File>Find import>Select>Associate (select 

patients)>Select CCDA (patients chart)>Import CCDA>Select Document>Reconcile>Select data by using the 

checkboxes>Use the arrows to move the data to the right>Reconcile All>Close Window 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 

Observed Errors and Verbalizations:                    

                             

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  

 

Administrator / Note-taker Comments:                  

                             



 
 

  
 

   

                             
 

170.315(b)(3) Electronic prescribing 

b.3  Task 35: Create New Prescription    

For this test you will create a new prescription for a patient. You will use the below information: 

Patient Name: New Prescription 

Medication to prescribe: 

Medication: Coumadin 3mg 

Dispense: 15 

Refills: 0 

Sig.: Take twice per day with full glass of water. 

Substitution: Substitution Allowed 

Pharmacy: TX Pharmacy 10.6MU 

Send the prescription. 

 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Search for patient > RX > Prescribe > Create a new prescription order > Send. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

b.3  Task 36: Change Prescription    

For this test you will change a prescription for a patient. You will use the below information: 

Patient Name: New Prescription 

Medication to change: 

Medication: Coumadin 3mg 

Dispense: 20 

Refills: 0 

Sig.: Take twice per day with full glass of water. 

Substitution: Substitution Allowed 

Pharmacy: TX Pharmacy 10.6MU 

Send the change request. 



 
 

  
 

   

 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: E-Prescribing > Change Requests > Respond and change. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

b.3  Task 37: Cancel Prescription    

For this test you will cancel a prescription for a patient. You will use the below information: 

Patient Name: New Prescription 

Medication to prescribe: 

Medication: Coumadin 3mg 

Dispense: 20 

Refills: 0 

Sig.: Take twice per day with full glass of water. 

Substitution: Substitution Allowed 

Pharmacy: TX Pharmacy 10.6MU 

Cancel the above prescription by removing it. 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Search for patient > RX > Remove > Accept pop up. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           



 
 

  
 

   

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  

 
 

b.3  Task 38: Refill Prescription    

For this test you will respond to a refill request for a prescription for a patient. You will use the below 

information: 

Patient Name: New Prescription 

Medication to prescribe: 

Medication: Coumadin 3mg 

Dispense: 20 

Refills: 0 

Sig.: Take twice per day with full glass of water. 

Substitution: Substitution Allowed 

Pharmacy: TX Pharmacy 10.6MU 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: E-Prescribing>Refill Request>Select Patient>Accept 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  
 

b.3  Task 39: Receive Fill Status Notice    

For this test you will review a fill status notice from the pharmacy. You will use the below information: 

Patient Name: New Prescription 

Medication to prescribe: 

Medication: Coumadin 3mg 

Dispense: 20 

Refills: 0 

Sig.: Take twice per day with full glass of water. 



 
 

  
 

   

Substitution: Substitution Allowed 

Pharmacy: TX Pharmacy 10.6MU 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: E-Prescribing > Fill Status > Review. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

 

Rating:  

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  

 

 

 
 

b.3  Task 40: Request and Receive Medication History    

For this test you will review a patient’s medication history. You will use the below information: 

Patient Name: New Prescription 

Success:  

 Easily completed   

 Completed with difficulty or help; Describe in Comments:  

 Not completed  

Comments:                           

                             

 

Task Time: ________ Seconds  

 

Optimal Path: Search for patient > Medications > Add > Pharmacy Benefit Manager. 

 Correct  

 Minor Deviations / Cycles :: Describe below  

 Major Deviations :: Describe below  

 

Comments:                           

                             

Rating:  



 
 

  
 

   

Overall, this task was: ______  

Show participant written scale: “Very Easy” (1) to “Very Difficult” (5)  

 


